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Waste Water Discharge Location Data Guidance Note 

ABOUT THESE GUIDANCE NOTES 
 
 
These guidance notes have been prepared to assist applicants in the preparation 
of an application for a Waste Water Discharge Licence. While every effort has been 
made to ensure the accuracy of the material contained in this document, the EPA 
assumes no responsibility and gives no guarantees, undertakings and warranties 
concerning the accuracy, completeness or up-to-date nature of the information 
provided herein and does not accept any liability whatsoever arising from any 
errors or omissions. 
 
Should there be any contradiction between the information requirements set out 
in the Application Form and any content contained in this Guidance Note, then the 
requirements in the Application Form should take precedence.  
 
For queries of an administrative or technical nature in relation to submitting 
digital drawing files and tabular data templates please contact: 
 

Mr. Gavin Smith 
Environmental Protection Agency 

Johnstown Castle Estate 
Co. Wexford 

 
Telephone: 053-9160600 
E-mail: g.smith@epa.ie
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Waste Water Discharge Location Data Guidance Note 

1.  INTRODUCTION 
 
During the licence application process applicants are required to submit drawings 
/ maps of the waste water works extent and boundary, site boundary and plan, 
primary discharge point, secondary discharge point(s), storm water overflow 
discharge point(s), and plant processes. In addition to submitting the drawings / 
maps in paper format with the application, applicants are required to submit 
digital drawing / map files electronically on a separate CD included with the 
application. The information should be supplied to the EPA in an electronic format 
and geo-referenced within the Irish National Grid system. The preferred format is 
ESRI Shapefile or MapInfo Tab files however geo-referenced AutoCAD files are 
also acceptable. The EPA incorporates these drawings / maps within the EPA’s 
geographical information management systems (GIS) to facilitate the licensing 
process. This document provides detailed guidance on the information required 
and the procedures for preparing data for submission with the licence application. 
 
 
2.  OVERVIEW OF DATA REQUIRED 
 
Applicants are required to submit geo-referenced digital drawing / map files (e.g. 
ESRI Shapefile, MapInfo Tab or AutoCad files) with the application, showing the 
following in Irish National Grid projection: 
 
• Agglomeration served by the waste water works showing the boundary clearly 

marked in red under section B.1 of the application. 

• Site boundary and overall site plan including labelled discharge, monitoring 
and sampling points under section B.2 of the application. 

• Primary discharge point including labelled monitoring and sampling points 
under section B.3 of the application. 

• Secondary discharge point(s) including labelled monitoring and sampling 
points under section B.4 of the application. 

• Storm water overflow discharge point(s) including labelled monitoring and 
sampling points under section B.5 of the application. 

• Plant or process drawings under section C.1 of the application. 

 
Acceptable drawing file formats include ESRI Shapefile, MapInfo Tab, DXF, DWG, 
DGN or other upon agreement with the EPA. This data should be submitted to the 
EPA on a separate CD-ROM. 
 
In addition to the drawing / map files applicants are required to submit tabular 
data templates outlining the following information: 
 
• The primary, secondary and storm water overflow discharge points as outlined 

in section D.2 of the application. The template will include information on the 
emission point code, emission type, local authority area, receiving water name 
and type, designation, Irish Grid reference (6E, 6N) and state if verified with a 
GPS. 

• The monitoring and sampling points as outlined in section E.3 of the 
application. The template will include information on the monitoring/sampling 
point code, point type, monitoring type, Irish Grid references (6E, 6N) and 
state if verified with a GPS. 

• The drinking water abstraction points downstream of primary and secondary 
emission points as outlined in section F.2 of the application. The template will 
include information on the agglomeration, agglomeration served, volume 
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abstracted, upstream discharge point code, distance downstream from 
discharge, Irish Grid references (6E, 6N) and state if verified with a GPS. 

 
The data for the above sections should be entered into separate tabular data 
templates and submitted to the EPA on the CD containing the digital drawing / 
map files outlined above. Tabular data templates can be downloaded from the 
Licensing pages of the EPA website at www.epa.ie.
 
 
3.  PREPARATION OF ESRI SHAPEFILE OR MAPINFO TAB MAP 

FILES 
 
The preferred format for the submission of drawings and maps is in ESRI 
Shapefile or MapInfo Tab file format for integration with the EPA Geographic 
Information System. If the maps and drawings have been produced or are 
available in ArcGIS or MapInfo systems they should be submitted to the EPA in 
this format. All maps and drawings should be projected in Irish National Grid with 
appropriate labels included as an attribute field within the mapping datasets. If 
the only format available is AutoCAD drawings the data must be projected in Irish 
National Grid (i.e. geo-referenced) using the steps outlined in section 4 
“Preparation of Digital AutoCAD Drawing Files”. 
 
 
4. PREPARATION OF DIGITAL AUTOCAD DRAWING FILES 
 
The preparation and submission of detailed drawings / maps outlining the site 
boundary, overall site plan, primary and secondary emission points, associated 
monitoring and sampling points, extent and boundary of waste water works, 
extent and boundary of agglomeration are a requirement of the application 
process. The EPA requires applicants to submit these site plans in a digital format 
(DXF, DWG, DGN, ESRI Shapefile, or MapInfo) and projected within the Irish 
National Grid projection system. The production of such drawings is most 
commonly carried out in AutoCAD. This section outlines the method for projecting 
AutoCAD files such as DXF, DWG and DGN formats in Irish Grid projection. 
 
The Irish Grid as mentioned above is the primary projection system used in 
Ireland and by the EPA. Point locations are represented by 6 digit Eastings and 
Northings.  For example 315986, 234395 is the Irish Grid Reference for the 
centre point of O’Connell Bridge in Dublin. Further technical details on the Irish 
National Grid coordinate system are available from the Ordnance Survey of 
Ireland website at www.osi.ie. The Irish National Grid is the projection system 
required for all digital drawing files and point locations being submitted to the EPA 
as part of the application process. 
 
Confirming a Drawing File’s Projection: 
 
To confirm whether or not a drawing has already been projected in Irish National 
Grid the drawing can be checked in AutoCAD using the following steps. 
  

1. Open the file in AutoCAD. 

2. In the lower left corner of the AutoCAD window, the co-ordinates of the 
drawing can be viewed.  If the co-ordinates are not visible, right click on 
the corner to turn them on (Fig. 1). 
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Fig.1: Location of Drawing Co-ordinates in the bottom left corner 
 

3. If the co-ordinates are large number of digits, similar to the known grid 
references it is probable that the drawing has already been projected in 
Irish National Grid.  This should be verified against known reference 
points. If drawings are verified as projected Irish National Grid they are 
ready for submission. 

4. If the co-ordinates are similar to the format -7.46, 53.20, it is likely that 
the drawing has been projected using decimal degrees. Drawings 
projected using decimal degrees should be re-projected in Irish National 
Grid. 

5. Drawings that are not projected will have co-ordinates near 0,0,0 when 
the cursor is moved towards the bottom left hand corner of the window.  
Such maps have been drawn using 0,0,0 as the base point and will need to 
be projected into the Irish National Grid as outlined in the next section of 
this document. 

 
Projecting a Drawing File in Irish National Grid: 
 
If it has been confirmed that the drawing file has not already been projected into 
the Irish National Grid, the file can be projected using the following steps.   
 
Before converting the drawing file   

1. Ensure that the correct Irish National Grid reference of at least one easily 
identifiable point in the drawing is known.  For example the most northerly 
emission point or the bottom left corner of the main building. 

 
2. In AutoCAD set the drawing units to metres:  

− Go to the Format menu, 
− Select Units (Fig.2),  
− In the Drawing Units dialog box that opens, choose metres as the 

Insertion Scale and click OK (Fig.3).   
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Fig.2: Format Menu, Select Units 
 
 

 
 

Fig.3: Drawing Units Window – Drawing units should be set to metres 
 
 

3. Open the .dwg file within AutoCAD 
− Go to the File menu, 
− Select Open, a new window should open to browse to the required 

drawing file. 
 

4. For ease of viewing, zoom to the extent of the drawing 
− Right click mouse, choose Zoom (Fig.4), 
− Right click mouse again, choose Zoom Extents (Fig.5), 
− Hit escape (Esc) on the keyboard. 
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Fig.5: Right Click 

 

Fig.4: Right Click – Zoom 

 

 
 
 
 

5. Ensure that the Object Snapping option in turned on  
− Go to the Tools menu, 
− Select Drafting Settings (Fig.6).   
− In the Drafting Settings dialog box, go to the Object Snap tab and 

select Object Snap On.  In the Object Snap Modes, ensure that at 
least endpoint, centre, node and intersection are turned on. Then 
click OK (Fig.7). 

−  
 

   
 

 Fig.6: Tools menu, Drafting Settings       Fig.7 Drafting Settings – ensure Object 
Snap is turned on  

 
 

6. Check the current co-ordinates of the drawing.  The co-ordinates of the 
drawing can be viewed in the very bottom left corner of the AutoCAD 
window (see section on “Confirming a Drawing Files Projection”).  If the 
drawing is not already geo-referenced, when the mouse cursor is moved 
towards the lower left hand corner of the screen, the co-ordinates should 
be 0,0,0 or close to that.   
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 Geo-Referencing the Drawing File (Fig.8) 

7. To move the scaled site drawing from its current co-ordinates to new Irish 
Grid co-ordinates carry out the following steps: 

− In the Command line 
    Type MOVE and hit the return key. 

− The user will be requested to SELECT OBJECTS 
   Type ALL 
    Hit return, users may have to hit return twice. 

− The user will then be asked to SPECIFY BASE POINT OR 
[DISPLACEMENT] 
 Using the mouse click onto the known base point on the 

screen. The base point is a point for which exact 6E 6N Irish 
National Grid references are known.  Ensure that the cursor 
snaps to exactly the right point. 

 

 
 

 Fig.8: Command lines for moving the drawing 
 
 

8. The user will then be asked to SPECIFY SECOND POINT, at this point 
type in the correct Irish National Grid Co-ordinates in the Command line 
and hit return.  If the drawing disappears from the screen zoom to the 
extent of the drawing by right clicking the mouse and choose zoom, then 
right clicking again and choose Zoom Extents.  

9. The drawing should now be accurately geo-referenced.  You can check this 
by moving the mouse over the point for which you have set the co-
ordinates.  In the lower left hand corner of the screen the new co-
ordinates of the drawing should be visible and should have changed from 
0,0,0 to coordinates similar to those just entered. 

10. The same process should be carried out for all drawings that are being 
submitted to the EPA as part of the application process.  

 

5.  PREPARATION OF TABULAR DATA TEMPLATES 
 
The preparation and submission of Irish National Grid references (6E 6N) for all 
primary and secondary emission points, monitoring and sampling points, and 
drinking water abstraction points is a requirement of sections E and F of the 
application form. The EPA also require applicants to submit this data in a digital 
format on tabular data templates (e.g. in Excel, Access files or similar on 
agreement). Separate tabular data templates for primary and secondary 
discharge points, monitoring and sampling points, and drinking water abstraction 
points are available for download on the Licensing pages of the EPA website at 
www.epa.ie. This section outlines the format of the tabular data templates and 
the type of information required within the templates. 
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Tabular Data Template for Primary, Secondary and Storm Water Overflow 
Discharge Points 

Applicants are required to list all primary, secondary and storm water discharge 
points as outlined in sections D.2 of the application. The template should be 
structured in the same way as the templates outlined in Fig.9 and Fig.10. One 
row should be assigned to each emission point with the correct information for 
each field. 
 
 

PT_CD PT_TYPE LA_NAME RWB_TYPE RWB_NAME DESIGNA
TION 

EASTING NORTHING VERIFIED 

Point 
Code 
Provide 
label 
ID’s  

Point Type 
(e.g., 
Primary/ 
Secondary/ 
Storm 
Water 
Overflow) 

Local 
Authority 
Name (e.g., 
Donegal 
County 
Council) 

Receiving 
Water Body 
Type (e.g., 
River, Lake, 
Groundwater, 
Transitional, 
Coastal) 

Receiving 
Water Body 
Name (e.g., 
River Suir) 
 
 

Protected 
Area Type 
(e.g., SAC, 
candidate 
SAC, NHA, 
SPA etc.)  

6E-digit 
GPS Irish 
National 
Grid 
Reference 

6N-digit 
GPS Irish 
National 
Grid 
Reference 

Y = GPS 
used 
N = GPS 
not used 

 
Fig.9: Structure of tabular data template for primary and secondary emission points 
 
 

PT_CD PT_TYPE LA_NAME RWB_TYPE RWB_NAME DESIGNA
TION 

EASTING NORTHING VERIFIED 

SW1 Primary Cork County 
Council 

River LEE NHA 158444 071375 Y 

SW2 Secondary Cork County 
Council 

Transitional LEE NHA 159493 071447 Y 

GW1 Secondary Cork County 
Council 

Groundwater Not 
Applicable 

Not 
Applicable 

160997 070875 Y 

 
Fig.10: Sample emission point data (sample data not real emission points) 
 
 
Tabular Data Template for Monitoring and Sampling Points 

Applicants are required to list all monitoring and sampling points as outlined in 
section E.3 of the application. The template should be structured in the same way 
as the templates outlined in Fig.11 and Fig.12. One row should be assigned to 
each monitoring and sampling point with the correct information for each field. 
 
 

PT_CD PT_TYPE MON_TYPE EASTING NORTHING VERIFIED 

Point Code 
Provide 
label ID’s 
assigned in 
section E of 
application 

Point Type 
(e.g., 
Primary, 
Secondary, 
Storm 
Water 
Overflow) 

Monitoring 
Type 
M = Monitoring 
S = Sampling 

6E-digit GPS 
Irish National 
Grid Reference 

6N-digit GPS 
Irish National 
Grid Reference 

Y = GPS used 
N = GPS not 
used 

 
Fig.11: Structure of tabular data template for emissions monitoring and sampling points 
 

PT_CD PT_TYPE MON_TYPE EASTING NORTHING VERIFIED 

aSW1u Primary M 158210 071390 Y 

aSW1d Primary M 158644 071571 Y 

aSW2u Secondary M 159145 071566 Y 

aSW2d Secondary M 160002 071371 Y 

GW1 Secondary M 160997 070875 Y 

 
Fig.12: Sample emissions monitoring and sampling point data (sample data not real 
emission points) 
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Tabular Data Template for Drinking Water Abstraction Points 

Applicants are required to list drinking water abstraction points downstream of 
primary and secondary emission points as outlined in section F.2 of the 
application.  The template should be structured in the same way as the templates 
outlined in Fig.13 and Fig.14. One row should be assigned to each drinking water 
abstraction point with the correct information for each field. 
 
 

ABS_CD AGG_SERVED ABS_VOL PT_CD DIS_DS EASTING NORTHING VERIFIED 

Abstraction 
Code 

Agglomeration 
served 

Abstraction 
Volume in 
m3/day 

Point 
Code 
Provide 
label 
ID’s  

Distance 
Downstream 
in meters 
from 
Emission 
Point to 
Abstraction 
Point 

6E-digit GPS 
Irish 
National Grid 
Reference 

6N-digit GPS 
Irish 
National Grid 
Reference 

Y = GPS 
used 
N = GPS 
not used 

 
Fig.13: Structure of tabular data template for drinking water abstraction points 
downstream of primary and secondary emission points 
 
 

ABS_CD AGG_SERVED ABS_VOL PT_CD DIS_DS EASTING NORTHING VERIFIED 

0400PUB10
01 

Cork City 25000 SW1 6756 164738 071454 Y 

0400PUB10
01 

Cork City 25000 SW2 6000 164738 071454 Y 

 
Fig.14: Sample of drinking water abstraction points downstream of primary and secondary 
emission points data (sample data not real emission points) 
 
 
 
6.  SUBMITTING DIGITAL DRAWING/ MAP FILES AND 

TABULAR DATA TEMPLATES 
 
All digital drawing / map files and tabular data templates should be submitted on 
a separate CD and delivered with the application to the EPA. The CD should 
contain the following data: 
 

1. Digital drawing file of site boundary and overall site plan including labelled 
monitoring and sampling points projected in Irish National Grid (section 
B.2 of application). 

2. Digital drawing file of primary discharge point including labelled monitoring 
and sampling points projected in Irish National Grid (section B.3 of 
application). 

3. Digital drawing file of secondary discharge point(s) including labelled 
monitoring and sampling points projected in Irish National Grid (section 
B.4 of application). 

4. Digital drawing file of all storm water overflow point(s) associated with 
waste water works including labelled monitoring and sampling points 
projected in Irish National Grid (section B.5 of application). 

5. Digital drawing file of all plant or process drawings projected in Irish 
National Grid (section C.1 of application). 

6. Digital tabular data template for all discharge points including 6E 6N Irish 
National Grid references for each point (section D.2 of application). 

7. Digital tabular data template for all monitoring and sampling points 
including 6E 6N Irish National Grid references for each point (section E.3 
of application). 
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8. Digital tabular data template for all drinking water abstraction points 
including 6E 6N Irish National Grid references for each point (section F.2 of 
application). 

 
It is recommended that the data be stored on the CD using the folder structure 
outlined in Fig.15. 
 

 
 

 Fig.15: Recommended folder structure for storing required data on CD 
 

 

Page 11 of 11 


	Providing
	Electronic Information
	on Waste Water Discharge Locations
	Application Guidance Notes

	ABOUT THESE GUIDANCE NOTES
	1.  INTRODUCTION
	2.  OVERVIEW OF DATA REQUIRED
	3.  PREPARATION OF ESRI SHAPEFILE OR MAPINFO TAB MAP FILES
	4. PREPARATION OF DIGITAL AUTOCAD DRAWING FILES
	5.  PREPARATION OF TABULAR DATA TEMPLATES
	LA_NAME
	LA_NAME
	ABS_CD
	ABS_CD




